
Fayol Inc. 0547824419 

SECOND TERM  
WEEKLY LESSON NOTES – B8 

WEEK 1 

Week Ending: 06-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  Sub Strand: Introduction to Presentation 

Content Standard:   

B82.2.1 Demonstrate how to use Microsoft 

PowerPoint (Multimedia) 

Indicator:  
B8.2.2.1.1. Demonstrate how to add pictures, 

screenshot and edit and format pictures 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can demonstrate how to add pictures, screenshot and edit and 

format pictures. 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Revise with learners on the use of the PowerPoint presentation application. 
• PowerPoint is easy to use and has a user-friendly interface that enables users to 

create engaging presentations quickly. 

• PowerPoint is versatile in that it can be used for various purposes, including business 

presentations, educational lectures, and personal projects. 

• PowerPoint presentations can help to enhance communication by presenting 

information in a clear and concise manner, and by incorporating visual aids that help 

to convey complex information more easily 

 

Let learners identify and discuss the features of the PowerPoint 

presentation window. 
• Title Bar: The title bar displays the name of the current presentation and allows you to 

minimize, maximize, or close the PowerPoint window. 

• Ribbon: The Ribbon is the main toolbar that contains various tabs, such as Home, Insert, 

Design, Transitions, Animations, etc., with each tab containing related groups of tools that allow 

you to perform various tasks in PowerPoint. 

• Quick Access Toolbar: The Quick Access Toolbar provides quick access to frequently used 

commands, such as Save, Undo, and Redo. 

• Slides Pane: The Slides pane displays all the slides in the current presentation, and allows you 

to add, delete, and rearrange slides as needed. 

• Notes Pane: The Notes pane allows you to add speaker notes that only you can see during a 

presentation. 

• Slide Area: The Slide Area is the main working area where you can create and edit your slides. 

• Status Bar: The Status Bar displays information about the current slide, such as the slide 

number and the view that you are currently using. 

Pictures and 

videos  

 



 
 

 

Guide learners to explore the use of the Images Group under the Insert 

tab.  

 
• Pictures: this allows you to add pictures from your computer, stock image library or 

from online source. 

• Screenshot: allows you to add a snapshot of any window that’s open on the desktop 

to your document. 

• Photo Album: It allows you to create a beautiful presentation for your favorite photo 

collection. 

 

Learners in groups demonstrate the use of ClipArt, Photo Album and 

Screenshot.  

 

Project examples of the PowerPoint interface to learners with the aid of a 

projector or pictures.  

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

State and explain the uses of five features of the PowerPoint presentation window 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 



 

Week Ending: 06-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  Sub Strand: Introduction to Presentation 

Content Standard:   

B82.2.1 Demonstrate how to use Microsoft 

PowerPoint (Multimedia) 

Indicator:  
B8.2.2.1.2. Demonstrate how to add a drawing 

canvas, shapes, and also edit, format and add text to 

shapes 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can demonstrate how to add a drawing canvas, shapes, and also 

edit, format and add text to shapes 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Explore the use of the Illustrations group under the Insert tab. 

 
• Shapes: this allows you to insert ready made shapes, such as circles, squares and 

arrows. 

• SmartArt: this allows to insert SmartArt graphics to visually communicate information. 

• Chart: this allows you to insert graphs that makes easy to spot patterns and trends in 

your data. 

Pictures and 

videos  

 



 
 

 

 

 

 

Engage learners to demonstrate the use of Shapes and SmartArt. 

 

Explore the use of the drawing canvas to group shapes. 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

State and explain the uses of five features of the PowerPoint presentation window 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 2 

Week Ending: 14-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  Sub Strand: Introduction to Presentation 

Content Standard:   

B82.2.1 Demonstrate how to use Microsoft 

PowerPoint (Multimedia) 

Indicator:  

B8.2.2.1.3 Demonstrate how to add text to 
shapes and arrange shapes 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can demonstrate how to add text to shapes and arrange shapes 
Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to explore the use of the Format Ribbon once a shape is 

selected  

 

Have learners to explore the editing features of the Insert Shapes and 

Shape Styles.  

 

Present a prepared project or exercise using what has been studied in 

Indicator 1 and 2. 

 

This is to help the learners with software knowledge in MS PowerPoint, 

Office Applications to grasp the concept well 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Pictures and 

videos  

 

Homework/Project Work/Community Engagement Suggestions 

State and explain the uses of five features of the PowerPoint presentation window 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 



 

 

Week Ending: 14-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  Sub Strand: Introduction to Presentation 

Content Standard:   

B82.2.1 Demonstrate how to use Microsoft 

PowerPoint (Multimedia) 

Indicator:  

B8.2.2.1.3 Demonstrate how to add text to 
shapes and arrange shapes 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can demonstrate how to add text to shapes and arrange shapes 
Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to explore the use of the Format Ribbon once a shape is 

selected  

 

Have learners to explore the editing features of the Insert Shapes and 

Shape Styles.  

 

Present a prepared project or exercise using what has been studied in 

Indicator 1 and 2. 

 

This is to help the learners with software knowledge in MS PowerPoint, 

Office Applications to grasp the concept well 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Pictures and 

videos  

 

Homework/Project Work/Community Engagement Suggestions 

State and explain the uses of five features of the PowerPoint presentation window 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 3 

Week Ending: 21-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1. Demonstrate how to use MS-Publisher 

Indicator:  

B8.2.3.1.1. Explain the importance of desktop 
publishing software (DTP 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can explain the importance of desktop publishing software 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to discuss the meaning of desktop publishing software.  

Desktop publishing (DTP) is the process of using specialized software to create 

documents and publications that incorporate text, images, and other visual 

elements 

 

Guide learners to identify some examples of desktop publishing softwares. 

 Adobe InDesign: This is one of the most popular DTP software used by 

professionals in the graphic design and publishing industry. 

 QuarkXPress: Another popular DTP software, QuarkXPress offers a 

comprehensive set of tools for layout and design, as well as for creating 

interactive digital publications. 

 Serif PagePlus: This is a comprehensive DTP software that is aimed at both 

home users and professionals. 

 Scribus: This is a free and open-source DTP software that is available for 

Windows, Mac, and Linux. 

 

Introduce learners to the Microsoft desktop publisher. 

Microsoft Publisher is a DTP software from Microsoft that is aimed at home and 

small business users. It offers a user-friendly interface and a variety of pre-

designed templates for creating flyers, brochures, newsletters, and other types of 

publications. 

 

 

Pictures and 

videos  

Learners are 

able to explain 

the importance 
of desktop 
publishing 
software 



Using the charts and pictures, guide learners to identify and discuss the 

features of the Microsoft Publisher. 

 Ribbon: The ribbon is located at the top of the window and contains tabs that 

group related commands together. The tabs include File, Home, Insert, Page 

Design, Layout, Review, and View. 

 Quick Access Toolbar: The Quick Access Toolbar is located above the ribbon 

and contains frequently used commands, such as Save, Undo, and Redo. 

 Pages Navigation Pane: The Pages Navigation Pane is located on the left side 

of the window and displays all the pages in the publication. 

 Publication Types: When users create a new publication, they can choose 

from a variety of publication types, such as Brochures, Newsletters, Flyers, 

and more.  

 Objects: The Objects section of the ribbon contains tools for adding and 

manipulating various objects in the publication, such as text boxes, pictures, 

shapes, and tables. 

 Design Themes: The Design Themes section of the ribbon contains a variety 

of pre-designed themes that users can apply to their publications. 

 Page Setup: The Page Setup section of the ribbon contains tools for setting up 

the page layout, such as page size, margins, and orientation. 

 

 

Brainstorm to elicit the importance of DTP.  

 DTP software allows users to create professional-looking publications that are 

visually appealing and well-organized. 

 It provides tools for designing layouts, adding graphics, and formatting text, 

which makes it easier to create high-quality publications that look polished 

and professional. 

 DTP software allows users to create publications in-house, reducing the need 

to outsource this work to graphic designers and printers. 

 DTP software allows users to create customized publications that are tailored 

to their specific needs. 

 
 

Assessment  

What is a DTP? 

Mention any five features of the Microsoft Publisher. State one use of the 

features identified. 

State three examples of DTP. 

 

 



Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

What is desktop publishing? 

State and explain four importance of desktop publishing software. 
Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



 

 

Week Ending: 21-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1. Demonstrate how to use MS-Publisher 

Indicator:  

B8.2.3.1.2 Create and save a new document 
from a blank or pre- designed template 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can create and save a new document from a blank or pre- 

designed template 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 30 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Engage learners to open a desktop publishing software (e.g. MS-Publisher).  

 

Guide them to create a new document from a blank publication  

 

Have learners create a new document from a pre-designed template.  

 

Save the document with the appropriate name  

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Pictures and 

videos  

Learners can 

create and save 
a new 
document from 
a blank or pre- 
designed 
template 

Homework/Project Work/Community Engagement Suggestions 

Learners in groups, create and save a new document from a blank or pre- designed template 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 4 

Week Ending: 28-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1. Demonstrate how to use 

MS-Publisher 

Indicator:  

B8.2.3.1.3 Demonstrate the use of the commands in MS-

Publisher ribbons under each tab (Home, Page Design, 

Mailings, Review, View) 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can demonstrate the use of the commands in MS-Publisher 

ribbons under each tab 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Revise with learners on the features of the MS-Publisher window. 

 

Working in pairs, explore the use of the commands in a desktop publishing 

software (e.g. MS-Publisher ribbons: Home, Page Design, Mailings, Review, 

 

Commands in the home Ribbon 

 New: Allows you to create a new publication from scratch or use a pre-

designed template. 

 Open: Allows you to open an existing publication. 

 Save: Allows you to save your publication. 

 Undo/Redo: Allows you to undo or redo your last action. 

 Cut/Copy/Paste: Allows you to cut, copy, or paste text and images. 

 Font: Allows you to choose a font and modify the font style and size. 

 Paragraph: Allows you to modify paragraph settings such as alignment, 

indentation, and spacing. 

 Bullets/Numbering: Allows you to add bullets or numbering to a list. 

 Styles: Allows you to apply a style to text, such as a heading or subheading. 

 Borders: Allows you to add a border around a text box or image. 

 Tables: Allows you to create and customize tables. 

 Pictures: Allows you to insert and modify images. 

 Shapes: Allows you to insert and modify shapes, such as rectangles or circles. 

Pictures and 

videos  

Demonstrating  

the use of the 

commands in 

MS-Publisher 

ribbons under 

each tab 



 Arrange: Allows you to arrange objects on the page, such as moving them 

forward or backward. 

 Design: Allows you to change the design or layout of the publication, such as 

choosing a different color scheme or adding a background. 

 View: Allows you to change the view of the publication, such as zooming in or 

out or switching to a different page. 

 

Commands in the Insert Ribbon 

 

 Pages: Allows you to add or delete pages in your publication, or duplicate a 

page. 

 Table: Allows you to insert a table and customize the table's size and design. 

 Picture: Allows you to insert a picture from a file, online source, or your own 

collection. You can also customize the picture's size and appearance. 

 Clip Art: Allows you to insert clip art images from a collection of pre-designed 

images. 

 Shapes: Allows you to insert and customize shapes, such as lines, rectangles, 

and circles. 

 Building Blocks: Allows you to insert pre-designed building blocks, such as 

calendars or borders, into your publication. 

 Text Box: Allows you to insert a text box and customize its size and 

appearance. 

 WordArt: Allows you to insert decorative text elements that can be 

customized with various font styles and effects. 

 Drop Cap: Allows you to create a large capital letter at the beginning of a 

paragraph. 

 Header & Footer: Allows you to add headers and footers to your publication, 

which can contain text or images. 

 Page Parts: Allows you to add pre-designed page elements, such as a sidebar 

or pull quote, to your publication. 

 Hyperlinks: Allows you to insert hyperlinks to web pages, email addresses, or 

other files. 

 

 

Assessment  

Identify and state one use of the commands in the Page Design and View 

ribbon. 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Identify and state one use of the commands in the Mailings and Review ribbon. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



 

 

Week Ending: 28-04-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1.Demonstrate how to use MS-Publisher 

Indicator:  

B8.2.3.1.4 Change the orientation and margins of 

a document 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can change the orientation and margins of a document 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 30 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Explore and change the orientation and margins of your document by 

working in pairs.  

 

To change the orientation and margins of a MS-Publisher document. 

 

1. Open the MS-Publisher document you want to modify. 

 

2. Click on the "Page Design" tab in the ribbon at the top of the screen. 

 

3. To change the orientation, click on the "Orientation" button and select either 

"Portrait" or "Landscape" from the dropdown menu. 

 

4. To adjust the margins, click on the "Margins" button and select a preset margin 

option, such as "Narrow," "Moderate," or "Wide." Alternatively, you can click on 

"Custom Margins" at the bottom of the dropdown menu to set your own custom 

margins. 

 

5. If you selected "Custom Margins," a new window will open where you can set 

your margins. Adjust the values for top, bottom, left, and right margins as desired. 

 

6. Click "OK" to apply the new margins and close the window. 

 

7. Save your changes to the document by clicking on "File" in the ribbon, then 

"Save" or "Save As" if you want to save a new copy of the document with the new 

orientation and margin settings. 

 

Assessment 

Pictures and 

videos  

Changing the 

orientation and 

margins of a 

document. 



Explain how you would change the orientation and margins of a MS-

Publisher document 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Learners in groups, create and save a new document from a blank or pre- designed template 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 5 

Week Ending: 05-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1. Demonstrate how to use 

MS-Publisher 

Indicator:  

B8.2.3.1.5 Add and modify pictures from different sources 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can add and modify pictures from different sources 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 29 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Ask learners to launch the MS Publisher. Revise with them some features of 

the publisher window. 

 

Learners in groups create documents by exploring the use of the 

commands in the various ribbons. 

 

Learners explore addition and modification of pictures from different 

sources to your document by working in pairs. 

 

To add and modify pictures from different sources in MS Publisher. 
1. Open your Publisher document and click on the "Insert" tab in the ribbon menu. 

2. Click on "Picture" and select the source of the picture you want to insert. You can 

choose to insert a picture from your computer, from the web, or from a variety of other 

sources. 

3. Once you've selected the picture, it will be inserted into your document. You can then 

resize it, move it around, and modify it as needed. 

 

To modify the picture, follow these steps: 
1. Click on the picture to select it. 

2. Click on the "Format" tab in the ribbon menu. 

3. From here, you can adjust the brightness, contrast, color, and other properties of the 

picture. You can also crop the picture, add effects, and apply various styles. 

4. You can also add borders and frames to your picture by selecting the "Picture Border" 

option from the "Format" tab. 

 

 

Pictures and 

videos  

Adding and 

modifying of 

pictures from 

different 

sources to MS 

Publisher 

document 



Assessment  

Describe how you would replace an existing picture with a new one in MS 

Publisher? 

Describe how you would add a text to pictures in MS Publisher? 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Identify and state one use of the commands in the Mailings and Review ribbon. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



 

 

Week Ending: 05-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1.Demonstrate how to use MS-Publisher 

Indicator:  

B8.2.3.1.6 Add and modify text using different 

font types 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can add and modify text using different font types 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 31 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to explore addition and modification of text using different 

font types in your document. 

 
1. Open your Publisher document and click on the "Home" tab in the ribbon menu. 

2. Click on the "Text Box" button in the "Objects" group to insert a new text box. 

Alternatively, you can click on an existing text box to edit the text within it. 

3. Type the text that you want to add to your document. 

4. To change the font of the text, select the text that you want to modify. 

5. Click on the "Font" dropdown menu in the "Font" group on the "Home" tab. 

6. Choose a font from the list of available fonts. You can also change the font size, style, 

and color from the same dropdown menu. 

7. If you want to use a font that is not available in the dropdown menu, click on the "More 

Fonts" option at the bottom of the dropdown list. This will open the "Font" dialog box, 

where you can choose from a wider variety of fonts. 

8. In the "Font" dialog box, you can also choose additional font options such as character 

spacing, text effects, and advanced typography settings. 

 

To modify existing text, 

 
1. Click on the text that you want to modify. 

2. Use the "Font" dropdown menu on the "Home" tab to change the font type, size, style, 

and color as desired. 

3. To format text as bold, italic, or underlined, use the "Bold," "Italic," and "Underline" 

buttons in the "Font" group. 

4. You can also adjust the spacing, alignment, and other formatting options from the 

"Paragraph" group on the "Home" tab. 

 

 

Assessment 

Can you import custom fonts into MS Publisher? 

Pictures and 

videos  

Adding and 

modifying text 

using different 

font types to 

MS Publisher 

document 



How can you apply the same font to multiple text boxes or objects in MS 

Publisher? 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Learners in groups, create and save a new document from a blank or pre- designed template 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 6 

Week Ending: 12-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1.Demonstrate how to use MS-Publisher 

Indicator:  

B8.2.3.1.6 Add and modify text using different 

font types 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can add and modify text using different font types 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 31 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to explore addition and modification of text using different 

font types in your document. 

 
1. Open your Publisher document and click on the "Home" tab in the ribbon menu. 

2. Click on the "Text Box" button in the "Objects" group to insert a new text box. 

Alternatively, you can click on an existing text box to edit the text within it. 

3. Type the text that you want to add to your document. 

4. To change the font of the text, select the text that you want to modify. 

5. Click on the "Font" dropdown menu in the "Font" group on the "Home" tab. 

6. Choose a font from the list of available fonts. You can also change the font size, style, 

and color from the same dropdown menu. 

7. If you want to use a font that is not available in the dropdown menu, click on the "More 

Fonts" option at the bottom of the dropdown list. This will open the "Font" dialog box, 

where you can choose from a wider variety of fonts. 

8. In the "Font" dialog box, you can also choose additional font options such as character 

spacing, text effects, and advanced typography settings. 

 

To modify existing text, 

 
1. Click on the text that you want to modify. 

2. Use the "Font" dropdown menu on the "Home" tab to change the font type, size, style, 

and color as desired. 

3. To format text as bold, italic, or underlined, use the "Bold," "Italic," and "Underline" 

buttons in the "Font" group. 

4. You can also adjust the spacing, alignment, and other formatting options from the 

"Paragraph" group on the "Home" tab. 

 

Pictures and 

videos  
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Assessment 

Can you import custom fonts into MS Publisher? 

How can you apply the same font to multiple text boxes or objects in MS 

Publisher? 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Learners in groups, create and save a new document from a blank or pre- designed template 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



Week Ending: 12-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Desktop 

Publishing 

Content Standard:   

B8.2.3.1. Demonstrate how to use 

MS-Publisher 

Indicator:  

B9.2.3.1.7 Create and present a Publisher document (flyer, 

advertisement, invitation cards, business cards) 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can create and present a Publisher document 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum P.g. 31 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Ask learners to launch the MS Publisher. Revise with them some features of 

the publisher window. 

 

Learners in groups create documents by exploring the use of the 

commands in the various ribbons. 

 

Learners explore addition and modification of pictures from different 

sources to your document by working in pairs. 

 

Guide learners to create a one-page Publisher document  

E.g. flyer, advertisement, invitation cards, business cards, etc.  

 

Present documents to demonstrate creative abilities. 

 

Assessment  

Learners create and present a Publisher document 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Pictures and 

videos  

Creating and 

presenting a 

Publisher 

document 

Homework/Project Work/Community Engagement Suggestions 

Learners create and present a Publisher document 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 7 

Week Ending: 19-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Electronic 

Spreadsheet 

Content Standard:   

B8.2.4.1. Demonstrate How to Use the Spreadsheet 

(using functions and complex formulas) 

Indicator:  

B8.2.4.1.1. Perform operations using 

functions and Built-in functions. 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can perform operations using functions and Built-in functions 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Enumerate the difference between formulas and functions.  

 

Formulas: 

1. Formulas are expressions or equations used to perform calculations or 

manipulate data within a software application or spreadsheet. 

2. They are typically written using mathematical operators, such as addition (+), 

subtraction (-), multiplication (*), and division (/), along with cell references, 

constants, and functions. 

3. Formulas are used to perform calculations on a single cell or a range of cells. 

4. They can incorporate logical operators, such as IF statements, to make 

decisions based on certain conditions. 

5. Formulas are often used in spreadsheet applications like Microsoft Excel or 

Google Sheets to perform calculations, create relationships between data, and 

generate dynamic results. 

 

Functions: 

1. Functions are pre-defined routines or procedures built into software applications 

or programming languages. 

2. They are designed to perform specific tasks or calculations and can accept 

input parameters, process them, and produce a result. 

3. Functions are written in a specific syntax, often with a function name followed 

by parentheses, and can take one or more arguments as input. 

4. They can be used to perform complex calculations, manipulate strings, handle 

dates and times, and perform various other operations. 

Pictures and 
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5. Functions are reusable and can be called from different parts of a program or 

used within formulas in spreadsheet applications. 

 

Guide learners to access built-in functions to perform operations on sample 

data.  

 

 

1. Mathematical Functions: 

   - SUM: Adds a range of numbers. 

   - AVERAGE: Calculates the average of a range of numbers. 

   - MAX: Finds the maximum value in a range. 

   - MIN: Finds the minimum value in a range. 

   - ROUND: Rounds a number to a specified number of decimal places. 

 

2. Statistical Functions: 

   - COUNT: Counts the number of cells in a range that contain numbers. 

   - COUNTA: Counts the number of non-empty cells in a range. 

   - COUNTIF: Counts the number of cells that meet a specified condition. 

   - SUMIF: Adds the cells that meet a specified condition. 

   - AVERAGEIF: Calculates the average of cells that meet a specified 

condition. 

 

3. Text Functions: 

   - CONCATENATE: Joins multiple text strings into one. 

   - LEFT: Extracts a specified number of characters from the beginning of a 

text string. 

   - RIGHT: Extracts a specified number of characters from the end of a 

text string. 

   - LEN: Calculates the number of characters in a text string. 

   - FIND: Searches for a text string within another text string and returns 

its position. 

 

4. Logical Functions: 

   - IF: Performs a logical test and returns one value if true and another 

value if false. 

   - AND: Returns true if all arguments are true. 

   - OR: Returns true if any argument is true. 

   - NOT: Reverses the logical value of its argument. 

 

5. Date and Time Functions: 

   - TODAY: Returns the current date. 

   - NOW: Returns the current date and time. 

   - DATE: Creates a date value using specified year, month, and day. 

   - DAY: Extracts the day value from a date. 

   - MONTH: Extracts the month value from a date. 

 

6. Lookup and Reference Functions: 

   - VLOOKUP: Searches for a value in the leftmost column of a table and 

returns a value in the same row from a specified column. 

   - HLOOKUP: Searches for a value in the top row of a table and returns a 

value in the same column from a specified row. 

   - INDEX: Returns a value or reference of a cell at the intersection of a 

specified row and column in a range. 

   - MATCH: Returns the relative position of a value within a range. 



 

Demonstrate the use of common spreadsheet functions such as SUM, 

AVERAGE, COUNT, COUNTA, COUNTIF, MAX and MIN.  

 

Assessment 

 In a spreadsheet, how would you use the SUM function to add up the 

values in cells A1 to A10? 

 You have a list of student scores in column C, and you want to count 

the number of students who scored above 80. Which function would 

you use, and what would be the formula? 

 Suppose you have a range of values in cells B1 to B8, and you want to 

calculate the average of all the non-empty cells in that range. Which 

function would you use, and what would be the formula? 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Suppose you have a column of dates in cells E1 to E10, and you want to extract the month value from 

each date. Which function would you use, and what would be the formula to achieve this? 
Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

 

  



 

 

Week Ending: 19-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Electronic 

Spreadsheet 

Content Standard:   

B8.2.4.1. Demonstrate How to Use the Spreadsheet 

(using functions and complex formulas) 

Indicator:  

B8.2.4.1.1. Perform operations using 

functions and Built-in functions. 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can add and modify text using different font types 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Enumerate the difference between formulas and functions.  

 

Formulas: 

1. Formulas are expressions or equations used to perform calculations or 

manipulate data within a software application or spreadsheet. 

2. They are typically written using mathematical operators, such as addition (+), 

subtraction (-), multiplication (*), and division (/), along with cell references, 

constants, and functions. 

3. Formulas are used to perform calculations on a single cell or a range of cells. 

4. They can incorporate logical operators, such as IF statements, to make 

decisions based on certain conditions. 

5. Formulas are often used in spreadsheet applications like Microsoft Excel or 

Google Sheets to perform calculations, create relationships between data, and 

generate dynamic results. 

 

Functions: 

1. Functions are pre-defined routines or procedures built into software applications 

or programming languages. 

2. They are designed to perform specific tasks or calculations and can accept 

input parameters, process them, and produce a result. 

3. Functions are written in a specific syntax, often with a function name followed 

by parentheses, and can take one or more arguments as input. 

4. They can be used to perform complex calculations, manipulate strings, handle 

dates and times, and perform various other operations. 

5. Functions are reusable and can be called from different parts of a program or 

used within formulas in spreadsheet applications. 
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Guide learners to access built-in functions to perform operations on sample 

data.  

 

 

1. Mathematical Functions: 

   - SUM: Adds a range of numbers. 

   - AVERAGE: Calculates the average of a range of numbers. 

   - MAX: Finds the maximum value in a range. 

   - MIN: Finds the minimum value in a range. 

   - ROUND: Rounds a number to a specified number of decimal places. 

 

2. Statistical Functions: 

   - COUNT: Counts the number of cells in a range that contain numbers. 

   - COUNTA: Counts the number of non-empty cells in a range. 

   - COUNTIF: Counts the number of cells that meet a specified condition. 

   - SUMIF: Adds the cells that meet a specified condition. 

   - AVERAGEIF: Calculates the average of cells that meet a specified 

condition. 

 

3. Text Functions: 

   - CONCATENATE: Joins multiple text strings into one. 

   - LEFT: Extracts a specified number of characters from the beginning of a 

text string. 

   - RIGHT: Extracts a specified number of characters from the end of a 

text string. 

   - LEN: Calculates the number of characters in a text string. 

   - FIND: Searches for a text string within another text string and returns 

its position. 

 

4. Logical Functions: 

   - IF: Performs a logical test and returns one value if true and another 

value if false. 

   - AND: Returns true if all arguments are true. 

   - OR: Returns true if any argument is true. 

   - NOT: Reverses the logical value of its argument. 

 

5. Date and Time Functions: 

   - TODAY: Returns the current date. 

   - NOW: Returns the current date and time. 

   - DATE: Creates a date value using specified year, month, and day. 

   - DAY: Extracts the day value from a date. 

   - MONTH: Extracts the month value from a date. 

 

6. Lookup and Reference Functions: 

   - VLOOKUP: Searches for a value in the leftmost column of a table and 

returns a value in the same row from a specified column. 

   - HLOOKUP: Searches for a value in the top row of a table and returns a 

value in the same column from a specified row. 

   - INDEX: Returns a value or reference of a cell at the intersection of a 

specified row and column in a range. 

   - MATCH: Returns the relative position of a value within a range. 

 

Demonstrate the use of common spreadsheet functions such as SUM, 

AVERAGE, COUNT, COUNTA, COUNTIF, MAX and MIN.  



 

Assessment 

 In a spreadsheet, how would you use the SUM function to add up the 

values in cells A1 to A10? 

 You have a list of student scores in column C, and you want to count 

the number of students who scored above 80. Which function would 

you use, and what would be the formula? 

 Suppose you have a range of values in cells B1 to B8, and you want to 

calculate the average of all the non-empty cells in that range. Which 

function would you use, and what would be the formula? 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Suppose you have a column of dates in cells E1 to E10, and you want to extract the month value from 

each date. Which function would you use, and what would be the formula to achieve this? 
Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 8 

Week Ending: 26-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Electronic 

Spreadsheet 

Content Standard:   

B8.2.4.1. Demonstrate How to Use the Spreadsheet 

(using functions and complex formulas) 

Indicator:  

B8.2.4.1.2 Demonstrate how to create 

complex formulas 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can demonstrate how to create complex formulas 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Guide learners to create complex formulas (e.g.  

 

Finding Percentages,  

To create a formula for finding a percentage in Excel, you can use the 

following steps: 

 

1. Determine the numbers you want to calculate the percentage of. For example, 

if you want to find 20% of 100, you have a base number of 100 and a 

percentage of 20%. 

 

2. Decide where you want to display the result. Choose a cell where you want the 

percentage result to appear. 

 

3. In the selected cell, start typing the formula. Begin with an equals sign (=) to 

indicate that you're entering a formula. 

 

4. Enter the base number followed by the multiplication operator (*). In our 

example, the base number is 100, so you would enter "100*". 

 

5. Next, enter the percentage value divided by 100. Since percentages are 

represented as decimals in calculations, divide the percentage value by 100. In our 

example, the percentage is 20%, so you would enter "20/100". 

 

6. Close the formula with a closing parenthesis ")". The complete formula would 

look like "=100*(20/100)". 

Pictures and 
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Creating  
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7. Press Enter to calculate the result. The cell will display the calculated 

percentage. In this case, the result would be 20, indicating 20% of 100. 

 

 

 

Commissions 

To create a formula for finding commissions in Excel, you can use the 

following steps as an example: 

 

1. Determine the commission rate or percentage. This is the rate at which the 

commission is calculated. For instance, let's say the commission rate is 5%. 

 

2. Identify the sales amount on which the commission is based. For example, if the 

sales amount is ₵1,000, you'll use this value in the formula. 

 

3. Decide where you want to display the commission result. Choose a cell where 

you want the commission amount to appear. 

 

4. In the selected cell, start typing the formula. Begin with an equals sign (=) to 

indicate that you're entering a formula. 

 

5. Enter the sales amount followed by the multiplication operator (*). In our 

example, the sales amount is ₵1,000, so you would enter "1000*". 

 

6. Next, enter the commission rate divided by 100 to convert it to a decimal. 

Since commission rates are typically represented as percentages, divide the 

commission rate by 100. In our example, the commission rate is 5%, so you would 

enter "5/100". 

 

7. Close the formula with a closing parenthesis ")". The complete formula would 

look like "=1000*(5/100)". 

 

8. Press Enter to calculate the result. The cell will display the commission amount. 

In this case, the result would be ₵50, indicating a 5% commission on a ₵1,000 

sale. 

 

Interest Rates 

To create a formula for finding interest rates in Excel, you can follow these 

steps: 

 
1. Determine the necessary information for calculating the interest rate. You will need the 

principal amount (the initial sum of money), the time period (in years), and the total 

amount (including the interest) at the end of the time period. 

 

2. Decide where you want to display the interest rate result. Choose a cell where you want 

the interest rate to appear. 

 

3. In the selected cell, start typing the formula. Begin with an equals sign (=) to indicate 

that you're entering a formula. 

 

4. Enter the formula for calculating the interest rate. The formula for finding the interest 

rate is typically derived from the compound interest formula: 

 =((Total Amount / Principal Amount)^(1/Time Period) - 1) * 100 

 



5. Replace "Total Amount" with the cell reference containing the total amount at the end 

of the time period. 

 

6. Replace "Principal Amount" with the cell reference containing the initial principal 

amount. 

 

7. Replace "Time Period" with the cell reference containing the time period in years. 

 

8. Close the formula with a closing parenthesis ")". The complete formula would look like: 

   =((B2/B1)^(1/B3) - 1) * 100 

 

9. Press Enter to calculate the result. The cell will display the interest rate as a percentage. 

 

Have learners understand that creating complex formulas requires practice 

and experimentation.  

 

Learners use Excel's help resources, tutorials, and community forums to 

enhance their understanding and proficiency in building complex formulas. 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

Let learners in groups create complex formulas 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

 

  



 

 

Week Ending: 26-05-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Productivity Software   

Class: B8 Class Size:  
Sub Strand: Introduction to Electronic 

Spreadsheet 

Content Standard:   

B8.2.4.1. Demonstrate How to Use the Spreadsheet 

(using functions and complex formulas) 

Indicator:  

B8.2.4.1.3. Demonstrate how to copy 

formulas and references 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can demonstrate how to copy formulas and references 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Demonstrate the procedure for copying and pasting formulas in a 

worksheet.  

 

Explore how to reference cells and ranges in a worksheet. 3. Demonstrate 

the use of relative and absolute cell referencing in creating formulas.  

 

Explore how to correct common formula errors.  

 

Complete a project that involves creating a set of formulas with common 

functions (e.g. simple interest formula)  

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Pictures and 

videos  

Copying  

formulas and 

references 

Homework/Project Work/Community Engagement Suggestions 

Let learners in groups demonstrate how to copy formulas and references 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 



Fayol Inc. 0547824419 

SECOND TERM  

WEEKLY LESSON NOTES – B8 

WEEK 9 

Week Ending: 02-06-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Communication Networks 

Class: B8 Class Size:  Sub Strand: Computer Networks   

Content Standard:   

B8.3.1.1. Identify the concept of computer 

networking for global communication 

Indicator:  

B8.3.1.1.1 Describe the data communication 

models for networks. 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can describe the data communication models for networks 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Brainstorm learners to explain data communication models. 

Data communication models refer to the conceptual frameworks that describe 

how data is transmitted and received between communication entities. 

 

Engage learners to give some examples of data communication models. 

1. Simplex Model 

2. Half-Duplex Model 

3. Full-Duplex Model 

4. Simplex Stop-and-Wait Model 

5. Pipelining Model 

6. OSI Model 

 

Guide learners to explain the Open System Interconnection (OSI) model. 

 

The Open System Interconnection (OSI) model is a conceptual framework that 

standardizes the functions of a communication system into seven different layers. 

Each layer in the OSI model has specific tasks and responsibilities, and they work 

together to facilitate communication between devices and networks.  

 

Learners to Identify the different layers in the OSI model.  

 

1. Physical Layer: The Physical layer is the lowest layer of the OSI model. It deals 

with the physical transmission of data, including the electrical, mechanical, and 

procedural aspects of communication. It defines the physical characteristics of the 

network, such as cables, connectors, and signaling. 

 

Pictures and 
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2. Data Link Layer: The Data Link layer provides a reliable and error-free transfer 

of data between adjacent network nodes. It handles the framing of data into 

frames, error detection and correction, flow control, and access to the physical 

medium. 

 

3. Network Layer: The Network layer is responsible for addressing, routing, and 

forwarding data packets across different networks. It determines the best path for 

data transmission, handles logical addressing, and manages network congestion. 

 

4. Transport Layer: The Transport layer ensures reliable delivery of data between 

end-to-end connections. It breaks down data into smaller segments, manages data 

sequencing, and provides error detection and recovery mechanisms. 

 

5. Session Layer: The Session layer establishes, manages, and terminates sessions 

between communicating devices. It allows for synchronization, checkpointing, and 

recovery of data in case of failures. 

 

6. Presentation Layer: The Presentation layer is responsible for data 

representation, encryption, compression, and formatting. It ensures that data from 

different systems can be understood by the receiving system. 

 

7. Application Layer: The Application layer is the highest layer in the OSI model. It 

provides services directly to the end-user applications. It includes protocols for 

tasks such as file transfer, email, web browsing, and remote access. 

 

Assessment 

Fill in the blanks with the appropriate layer of the OSI model. 

 

1. The ______ layer is responsible for addressing and routing data packets 

across different networks. 

 

2. The ______ layer ensures reliable delivery of data between end-to-end 

connections. 

 

3. The ______ layer provides a reliable and error-free transfer of data 

between adjacent network nodes. 

 

4. The ______ layer handles the framing of data into frames, error 

detection and correction, and flow control. 

 

5. The ______ layer establishes, manages, and terminates sessions between 

communicating devices. 

 

6. The ______ layer is responsible for data representation, encryption, 

compression, and formatting. 

 

7. The ______ layer is the lowest layer of the OSI model, dealing with the 

physical transmission of data. 

 

8. The ______ layer provides services directly to end-user applications. 

 

9. The ______ layer allows for synchronization, checkpointing, and 

recovery of data in case of failures. 

 



10. The ______ layer handles the physical characteristics of the network, 

such as cables and connectors. 

 

11. The ______ layer is responsible for breaking down data into smaller 

segments, managing data sequencing, and providing error detection and 

recovery. 

 

12. The ______ layer includes protocols for tasks such as file transfer, 

email, web browsing, and remote access. 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 What is the purpose of the OSI model? 

 Why is it important to divide the communication process into layers? 

 How does the OSI model help troubleshoot network issues? 

 Give an example of a protocol that operates at each layer of the OSI model. 

 Describe a real-world scenario where the OSI model is used in networking. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



 

 

Week Ending: 02-06-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Communication Networks 

Class: B8 Class Size:  Sub Strand: Computer Networks   

Content Standard:   

B8.3.1.1. Identify the concept of computer 

networking for global communication 

Indicator:  

B8.3.1.1.1 Describe the data communication 

models for networks. 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can describe the data communication models for networks 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Discuss the purpose or benefits of the layers in ensuring interoperability of 

different hardware devices.  

 

1. Modularity: The layered approach allows for modularity in design. Each layer 

has a specific set of functions and responsibilities, which can be developed and 

implemented independently. This modularity simplifies the design process and 

enables the use of different hardware devices from multiple vendors. 

 

2. Interoperability: The layers ensure interoperability between different hardware 

devices by providing standardized interfaces and protocols. Each layer 

communicates with the corresponding layer in another device using well-defined 

protocols, enabling devices from different manufacturers to communicate 

seamlessly. 

 

3. Abstraction: The layers provide a level of abstraction, hiding the complexities of 

lower layers from the higher layers. Each layer can focus on its specific tasks 

without needing to understand the intricacies of other layers. This abstraction 

simplifies development and maintenance and allows for easier upgrades or 

replacements of specific layers without affecting the overall system. 

 

4. Flexibility: The layered approach allows for flexibility in adapting to changing 

technologies and requirements. As long as the interfaces and protocols between 

layers remain consistent, new hardware devices can be introduced or existing 

devices can be upgraded without affecting the compatibility with other devices. 

This flexibility promotes innovation and scalability in communication systems. 

 

5. Troubleshooting and Maintenance: The layered structure simplifies 

troubleshooting and maintenance. If an issue occurs, it can be localized to a 
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specific layer, making it easier to identify and resolve the problem. Network 

administrators can focus on the affected layer without disrupting the functionality 

of other layers. 

 

6. Standardization: The layers facilitate standardization of protocols and 

interfaces, ensuring compatibility and interoperability among different hardware 

devices. Standards are crucial for creating a common language for 

communication, allowing devices from various manufacturers to work together 

seamlessly. 

 

Assessment 

Fill in the blanks with the appropriate terms related to the benefits of 

layered communication in ensuring interoperability of different hardware 

devices. 

 

1. The ____________ approach in communication allows for modularity 

and independent development of each layer. 

 

2. ____________ refers to the seamless communication between devices 

from different manufacturers. 

 

3. Layers provide a level of ____________, hiding the complexities of 

lower layers from the higher ones. 

 

4. The layered structure enables flexibility in adapting to ____________ 

technologies and requirements. 

 

5. ____________ simplifies troubleshooting by localizing issues to specific 

layers. 

 

6. ____________ of protocols and interfaces promotes compatibility and 

interoperability. 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 Why is modularity important in the design of communication systems? 

 How does interoperability benefit users in a networked environment? 

 Explain the concept of abstraction in the context of layered communication. 

 Give an example of how the layered approach allows for flexibility in a communication system. 

 Why is standardization crucial for ensuring compatibility among different hardware devices? 

 How does the layered structure simplify troubleshooting and maintenance? 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 
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Week Ending: 09-06-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Communication Networks 

Class: B8 Class Size:  Sub Strand: Computer Networks   

Content Standard:   

B8.3.1.1. Identify the concept of computer 

networking for global communication 

Indicator:  

B8.3.1.1.2 Describe the Internet, world wide web 

(www) and Internet Protocol (IP) addresses 

Lesson: 

 

1 of 2 

Performance Indicator:  

Learners can describe the Internet, world wide web (www) and Internet 

Protocol (IP) addresses 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Brainstorm learners to explain internet addresses. 

Internet addresses, also known as IP addresses, are unique numeric identifiers 

assigned to devices connected to the Internet. They serve as the "address" for 

each device, allowing them to send and receive data over the Internet. 

 

Describe the Internet and the classes of internet addresses.  

 

The Internet is a global network of interconnected computers and devices that 

enables communication and the sharing of information worldwide. It is a vast 

network that connects millions of computers, servers, and other devices through 

various communication protocols. 

 

Internet Addresses: 

 

1. IP version 4 (IPv4) Addresses: 

 IPv4 addresses are 32-bit numeric addresses expressed in four sets of 

decimal numbers separated by periods (e.g., 192.168.0.1). 

 IPv4 addresses are divided into classes: 

 Class A: Used for large networks, with the first octet indicating the network 

portion and the remaining three octets for hosts. 

 Class B: Used for medium-sized networks, with the first two octets indicating 

the network portion and the remaining two octets for hosts. 

 Class C: Used for small networks, with the first three octets indicating the 

network portion and the last octet for hosts. 
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 Class D: Reserved for multicasting. 

 Class E: Reserved for experimental purposes. 

 

2. IP version 6 (IPv6) Addresses: 

 IPv6 addresses are 128-bit hexadecimal addresses expressed in eight groups 

of four hexadecimal digits separated by colons (e.g., 

2001:0db8:85a3:0000:0000:8a2e:0370:7334). 

 IPv6 addresses provide a much larger address space compared to IPv4, 

allowing for the growth of internet-connected devices. 

 

3. Domain Names: 

 Domain names are user-friendly, alphanumeric names used to identify 

websites and other internet resources. 

 They provide a more human-readable format for accessing websites instead 

of using IP addresses directly. 

 Domain names are mapped to IP addresses through the Domain Name 

System (DNS) to enable browsing the internet using familiar names. 

 

4. Subnetting: 

 Subnetting is a technique used to divide a large network into smaller 

subnetworks, allowing for more efficient allocation of IP addresses. 

 Subnetting helps manage network resources, improve security, and optimize 

network performance. 

 

 

Explain the internet Domain Name Server (DNS), which is equivalent to the 

function of a phonebook.  

 

The Internet Domain Name Server (DNS) is a critical component of the Internet 

infrastructure. It functions as a decentralized directory or "phonebook" that 

translates human-readable domain names into their corresponding IP addresses. 

Just as a phonebook helps us find the phone numbers of individuals or businesses, 

the DNS enables the translation of domain names (e.g., www.example.com) into 

IP addresses (e.g., 192.0.2.1) that computers and servers can understand. 

 

When a user enters a domain name in a web browser, such as requesting to visit 

a website, the browser initiates a DNS lookup. The DNS system then goes 

through a process to locate and retrieve the IP address associated with that 

domain name. This process involves querying multiple DNS servers until it finds 

the authoritative DNS server for the requested domain. 

 

The DNS system is hierarchical, with multiple levels of DNS servers. At the top 

level are the root DNS servers that maintain information about the top-level 

domains (.com, .org, .net, etc.). Below the root servers are the top-level domain 

(TLD) servers, which store information about specific domain extensions (e.g., 

.com, .org). Further down are the authoritative DNS servers for individual domains, 

which hold the specific IP address records for corresponding domain names. 

 

Assessment 

Fill in the blanks with the appropriate words to complete the sentences. 

 

1. IPv4 addresses are expressed in ______ sets of decimal numbers 

separated by periods. 

2. Class A addresses are used for ______ networks. 



3. Class B addresses are used for ______ networks. 

4. Class C addresses are used for ______ networks. 

5. The DNS system is ________ and consists of multiple levels of DNS 

servers. 

6. The ________ ________ servers maintain information about the top-

level domains. 

7. The authoritative DNS servers hold the ________ ________ records 

for specific domain names. 

8. The DNS system ensures seamless and transparent translation between 

________ names and IP addresses. 

9. The DNS allows users to access websites, send emails, and perform 

other online activities without needing to remember ________ ________. 

10. The DNS plays a crucial role in the functioning of the ________ by 

providing a mapping between domain names and IP addresses. 

 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 The DNS stands for ________ ________ ________ ________. 

 The DNS acts as a ________ ________, translating domain names into IP addresses. 

 The DNS helps computers and servers understand the ________ ________ associated with a domain 

name. 

 A DNS lookup is initiated when a user enters a ________ ________ in a web browser. 

 IPv6 addresses are expressed in ______ groups of four hexadecimal digits separated by colons. 

 Domain names provide a ______ format for accessing websites. 

 Domain names are mapped to IP addresses through the ______. 

 Subnetting is a technique used to divide a large network into ______ subnetworks. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 

  



 

 

Week Ending: 09-06-2023 DAY:  Subject: Computing 

Duration: 60mins Strand: Communication Networks 

Class: B8 Class Size:  Sub Strand: Computer Networks   

Content Standard:   

B8.3.1.1. Identify the concept of computer 

networking for global communication 

Indicator:  

B8.3.1.1.2 Describe the Internet, world wide web 

(www) and Internet Protocol (IP) addresses 

Lesson: 

 

2 of 2 

Performance Indicator:  

Learners can describe the Internet, world wide web (www) and Internet 

Protocol (IP) addresses 

Core Competencies: 

CC8.2: CP6.1 

Reference: Computing Curriculum Pg. 32 

 

Activities For Learning & Assessment Resources Progression  

Starter (5mins) 
 

Revise with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35mins) 
 

Distinguish between IPv4 and IPv6 addresses.  

 

1. Address Length: 

 IPv4: IPv4 addresses are 32 bits long and expressed in four sets of decimal 

numbers (ranging from 0 to 255) separated by periods. For example, 

192.168.0.1. 

 IPv6: IPv6 addresses are 128 bits long and expressed in eight groups of four 

hexadecimal digits separated by colons. For example, 

2001:0db8:85a3:0000:0000:8a2e:0370:7334. 

 

2. Address Space: 

 IPv4: IPv4 addresses provide a limited address space, allowing approximately 

4.3 billion unique addresses. 

 IPv6: IPv6 addresses offer an extensively larger address space, allowing for 

approximately 340 undecillion unique addresses. This vast address space was 

designed to accommodate the growing number of internet-connected devices. 

 

3. Address Notation: 

 IPv4: IPv4 addresses are typically represented in decimal notation, such as 

192.168.0.1, making them easier for humans to read and remember. 

 IPv6: IPv6 addresses are represented in hexadecimal notation, such as 

2001:0db8:85a3:0000:0000:8a2e:0370:7334, which is more complex but 

necessary due to the larger address space. 

 

4. Address Configuration: 
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 IPv4: IPv4 addresses can be configured statically (manually assigned) or 

dynamically assigned through protocols like Dynamic Host Configuration 

Protocol (DHCP). 

 IPv6: IPv6 addresses can also be configured statically or dynamically assigned, 

but they can also be automatically assigned through the stateless address 

auto configuration (SLAAC) process. 

 

5. Address Transition: 

 IPv4: Due to the limited address space, IPv4 addresses are gradually being 

exhausted. To cope with this, techniques like Network Address Translation 

(NAT) are used to share a single public IP address among multiple devices. 

 IPv6: IPv6 was developed to address the address exhaustion issue of IPv4 and 

provide ample address space for future growth. However, IPv6 adoption is still 

ongoing, and many networks operate with dual-stack configurations, 

supporting both IPv4 and IPv6. 

 

 

Explore the difference between internet and world wide web (www). 
 

1. Definition: 

 Internet: The Internet is a global network of interconnected computers and 

networks. It is a vast infrastructure that enables the exchange of data and 

communication between devices across the globe. 

 World Wide Web: The World Wide Web, often referred to as the Web, is an 

information system within the broader Internet. It consists of a collection of 

interconnected documents and resources that are accessible through the use 

of hyperlinks. 

 

2. Function: 

 Internet: The Internet serves as the underlying infrastructure that connects 

devices worldwide, allowing them to communicate and share information. It 

provides various services such as email, file transfer, remote access, and more. 

 World Wide Web: The World Wide Web is a subset of the Internet that 

facilitates the retrieval and display of web pages and multimedia content. It is 

a way to access and navigate through interconnected websites and web-based 

applications using web browsers. 

 

3. Structure: 

 Internet: The Internet is a decentralized network comprised of interconnected 

networks and devices. It operates on a set of protocols, such as TCP/IP 

(Transmission Control Protocol/Internet Protocol), which enable the routing 

and transmission of data packets across different networks. 

 World Wide Web: The World Wide Web is a system built on top of the 

Internet that uses protocols like HTTP (Hypertext Transfer Protocol) to 

facilitate the retrieval and display of web pages. It relies on the infrastructure 

provided by the Internet to deliver content to users. 

 

4. Scope: 

 Internet: The Internet encompasses a wide range of services beyond the 

World Wide Web. It includes technologies like email, instant messaging, 

online gaming, streaming media, cloud computing, and more. 

 World Wide Web: The World Wide Web specifically refers to the collection 

of interconnected websites and web-based resources that can be accessed 



through web browsers. It primarily focuses on the delivery of hypertext 

documents, multimedia content, and interactive applications. 

 

Assessment 

 

1. The __________ is a global network of interconnected computers and 

networks. 

2. The __________ is an information system within the broader Internet. 

3. The Internet serves as the underlying infrastructure that connects devices 

worldwide, while the __________ facilitates the retrieval and display of 

web pages and multimedia content. 

4. The Internet is a decentralized network comprised of interconnected 

networks and devices, while the World Wide Web is a system built on top 

of the __________. 

5. IPv4 addresses are typically represented in ______ notation, such as 

192.168.0.1. 

6. IPv6 addresses are represented in ______ notation, such as 

2001:0db8:85a3:0000:0000:8a2e:0370:7334. 

7. IPv4 addresses can be configured statically or dynamically assigned 

through protocols like ______. 

8. IPv6 addresses can be configured statically or dynamically assigned, and 

they can also be automatically assigned through the ______ process. 

9. IPv4 addresses are gradually being exhausted, and techniques like 

______ are used to share a single public IP address among multiple devices. 

10. IPv6 was developed to address the address exhaustion issue of IPv4 and 

provide ample address space for future growth, but many networks operate 

with ______ configurations, supporting both IPv4 and IPv6. 

 

 

 

Reflection (10mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

 IPv4 addresses are expressed in ______ sets of decimal numbers separated by periods. 

 IPv6 addresses are expressed in ______ groups of four hexadecimal digits separated by colons. 

 IPv4 addresses provide a ______ address space, allowing approximately 4.3 billion unique addresses. 

 IPv6 addresses offer an extensively larger address space, allowing for approximately ______ unique 

addresses. 

 The Internet provides various services such as email, file transfer, remote access, and more, while the 

World Wide Web primarily focuses on the delivery of __________. 

 The Internet operates on protocols like __________, which enable the routing and transmission of data 

packets, while the World Wide Web uses protocols like __________ for the retrieval and display of web 

pages. 

 The Internet is the broader infrastructure, while the World Wide Web is a __________ within it. 

 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

None 

 


